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Esipuhe

Tässä ohjeessa esitellään kemian opinnoissa ja erityisesti raportoinnissa tar-
vittavia ohjelmistoja sekä tulosten ja matemaattisten tai kemiallisten kaa-
vojen esittämiseen liittyviä sääntöjä. Raportoinnissa tarvittavien ohjelmis-
tojen käyttö kannattaa aloittaa mahdollisimman varhaisessa vaiheessa opin-
toja, jotta niistä saa parhaan hyödyn opiskelun edetessä. Ohjeessa esitellyt
ohjelmistot on valittu siten, että ne löytyvät valmiiksi asennettuina kemian
laitoksen koneilta tai opiskelijat voivat asentaa ne ilmaiseksi henkilökohtai-
sille koneilleen. Ohje on päivitetty versio Jussi Ahokkaan 2013 laatimasta
ohjeesta Raportoinnin välineitä.
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1 KUVAAJAT

1 Kuvaajat

Kuvaajien avulla voidaan esittää mittaustulokset havainnollisessa muodossa.
Tässä ohjeessa piirretään oheisen taulukon tiedot kuvaajaan OriginPro 2017
ja Microsoft Excel (Office 365) ohjelmistoilla.

Tulokset, joista kuvaaja piirretään, on tässä esitetty vain listana. Myöhem-
min tässä ohjeessa tulokset esitetään oikeaoppisesti taulukkomuodossa.

Tulokset:
Aika (s) 1/[A] (l/mol)

0 10
50 15
100 20
150 25
200 30
250 35

1.1 Kuvaaja OriginPro 2017 ohjelmistolla

OriginPro 2017 on asennettu kemian laitoksen opiskelijakoneille. Yliopistolta
ei ole saatavilla ohjelmasta kotikoneille asennettavaa versiota, joten kotikäyt-
töön ohjelmisto täytyy hankkia omalla kustannuksella.

Ohje kuvaajan piirtämiseksi Originilla.

1. Käynnistä ohjelmisto. Ohjelmisto löytyy Start-/Käynnistävalikosta kan-
siosta OriginLab

2. Ohjelma käynnistyy ja työpöydällä avautuu tyhjä työkirja (Book1).
Jos työkirjaa ei ole avoinna saat sen työkalurivin painikkeesta New
Workbook.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

3. Syötä arvot sarakkeisiin A(X) ja B(Y). Nyt x-akselille (sarake A(X)) tu-
lee aika ja y-akselille (sarake B(Y)) konsentraation käänteisluku 1/[A].

4. Maalaa piirrettävät arvot ja paina hiiren oikeaa nappia. Valitse Plot
→ Symbol → Scatter. Saman voit tehdä myös työkalurivin Plot -
valikosta.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

5. Nyt ruudulle saatiin kuvaaja, jossa mittapisteet on merkitty symbo-
leilla (mustat neliöt). X-akselilla on aika ja y-akselilla konsentraation
käänteisluku.

6. Laitetaan akseleille oikeat otsikot ja yksiköt näkyviin: tuplaklikkaa x-
akselin alla olevaa A:ta. Pyyhi merkit pois laatikosta ja kirjoita otsikko
ja yksikkö. Tee sama y-akselin otsikolle B.

7. Nyt kuvaa voi muokata helposti:

• Oikeassa yläkulmassa olevan Legend -laatikon voi poistaa klikkaa-
malla sitä ja painamalla delete. Tarvittaessa sen voi palauttaa
valitsemalla Graph → Legend → Reconstruct Legend.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

Laatikkoon voi kirjoittaa tuplaklikkaamalla selitteen symbolimerk-
kiä. Selite on erityisen hyvä silloin, jos samassa kuvassa on useita
eri mittaustuloksia eri symbolein esitettynä.

• Akseleita ja niiden merkintöjä voi muokata tuplaklikkaamalla ak-
selia, jolloin avautuu uusi ikkuna, jossa voit säätää kuvan asetuk-
sia.

• Tärkeimmät kuvan asetukset:

– Scale -välilehti

∗ Vasen laita: valitse joko x- (Horizontal) tai y-akselin
(Vertical) asetukset.

∗ From ja To ovat akselin alku- ja loppuarvot.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

∗ Major Ticks -valikosta voita asentaa jakovälin (Value)
akselilla esitettäville lukuarvoille. Varmista, että Type -
valikossa on valittuna By Increment.

∗ Minor Ticksmäärittää esitettyjen lukuarvojen välisen ja-
kovälin akselille. Varmista, että Type -valikossa on valit-
tuna By Counts.

– Title -välilehti

∗ Valitse vasemmasta laidasta akseli mitä haluat muokata.

∗ Color, Font ja Size -valikoista voit muokata valitun ak-
selin otsikon väriä, fonttia ja fontin kokoa.

– Line and Ticks -välilehti

∗ Valitse vasemmasta laidasta akseli mitä haluat muokata.

∗ Line -valikossa voit muokata akselin viivan väriä (Color),
paksuutta (Thickness) ja paikkaa (Axis Position).

∗ Major Ticks -valikossa voit muokata jakovälin tyyliä (Style),
pituutta (Length), väriä (Color) ja paksuutta (Thickness).

∗ Minor Ticks -valikossa voit muokata jakovälien jaottelun
tyyliä (Style), pituutta (Length), väriä (Color) ja pak-
suutta (Thickness).

∗ Joskus voi olla tarpeen katkaista x- tai y-akseli ja jatkaa
sitten katkon jälkeen halutulla arvolla. Näitä voi säätää
Break -välilehdellä.

– Kuvaajan symboleita voi muokata tuplaklikkaamalla symbo-
lia.

• Tässä esitettyjen muokkaustoimintojen avulla kuvasta saa vaikka-
pa tämän näköisen:
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

8. OriginProssa työt tallennetaan projekteina: File→ Save Project As.

9. Varsinainen kuvaaja tallennetaan kuvatiedostona, jotta se voidaan liit-
tää kuvana esim. työselostukseen. Valitse kuvaajan ikkuna aktiivisek-
si ja valitse File → Export Graphs → Open Dialog. Valitse kuvan
tiedostomuoto (tyypillisesti jpg, gif tai png toimii hyvin), tiedostoni-
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

mi, tiedostopolku, resoluutio (mielellään 600 tai suurempi) ja tallenna.
Voit myös esikatsella kuvaa.

10. Tallennuksen jälkeen kuvan voi tuoda omaan työhön eri ohjelmistois-
ta riippuvalla tavalla. Valmis kuva näyttää tältä, kun kuvan jokaiselle
reunalla on laitettu viivat ja jakovälit:
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Kuva 1. Esimerkkikuva OriginPro:lla tehdystä kuvaajasta.

11. Käydään vielä läpi kuinka samassa kuvaajassa voi esittää kahdet eri
tulokset. Käytetään esimerkissä alla olevia tuloksia.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

Tulokset 1:
Aika (s) 1/[A] (l/mol)

0 10
50 15
100 20
150 25
200 30
250 35

Tulokset 2:
Aika (s) 1/[A] (l/mol)

0 10
25 15
75 20
125 25
175 30
225 35

12. Klikkaa hiiren oikeaa nappia työkirjan harmaalla alueella ja valitse Add
New Column.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

13. Toista tämä kaksi kertaa ja saat kaksi uutta saraketta - C(Y) ja D(Y)
- työkirjaan. Mikäli mittaussarjoilla on yhteinen x-akseli (samat x-
pisteiden arvot), voit jättää toisen sarakkeista pois ja ja siirtyä suoraan
kohtaan 15.

14. Sarakkeen C:n oletusarvo on Y, joten se pitää muuttaa X:ksi. Valitse
sarake C → paina hiiren oikeaa nappia → valitse avautuvasta ponnah-
dusvalikosta Set As → X.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

15. Kopioi Tulokset 2 tiedoista aika sarakkeeseen C(X) ja konsentraation
käänteisluku sarakkeeseen D(Y). Taulukon tulisi näyttää tältä.

16. Maalaa kaikki arvot sarakkeista A(X1), B(Y1), C(X2) ja D(Y2) ja pai-
na hiiren oikeaa nappia. Valitse Plot → Symbol → Scatter. Saman
voit tehdä myös työkalurivin Plot -valikosta.

17. Muodostuva kuvaaja on esitetty alla ja siinä on merkattu mustilla ne-
liöillä Tulosten 1 datapisteitä, kun taas Tulosten 2 datapisteet on esi-
tetty punaisten pallojen avulla. Toistamalla kohdat 12–16 voit lisätä
useampia mittaussarjoja samaan kuvaajaan.
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1.1 Kuvaaja OriginPro 2017 ohjelm‌ . . . 1 KUVAAJAT

18. Voit seuraavaksi muokata yllä olevien ohjeiden (kohdat 5-10) mukaan
kuvaajasta julkaisukelpoisen. Lopputuloksen pitäisi näyttää tältä:

Kuva 2. Esimerkkikuva OriginPro:lla tehdystä kuvaajasta.

19. Työselostuksessa kuvat tulee numeroida ja niihin tulee lisätä kuvateksti
kuvan alapuolelle. Kuvateksti päättyy pisteeseen.

OriginPro on hyvin laaja ohjelmisto, jossa on paljon erilaisia ominaisuuksia.
Tässä rajoituttiin vain kuvaajan piirtämisen perusteisiin.
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1.2 Kuvaaja Microsoft Excelillä 1 KUVAAJAT

1.2 Kuvaaja Microsoft Excelillä

Tässä ohjeessa esitetään kuvaajan tekeminen Office 365 pakettin Excel ver-
siolla. Tämä ohje käsittelee vain kuvaajan piirtämisen. Lisäohjeita saa Exce-
lin Help-valikosta ja internetistä. Lisäksi Exceliä käsittelevää kirjallisuutta
löytyy kirjastoista ja kirjakaupoista.

Office 365 paketin Excel on asennettuna kaikille yliopiston työasemille. Opis-
kelijat voivat myös asentaa Office ohjelmistot omille koneilleen yliopiston
lisenssillä. Huom. selaimessa toimivat Office ohjelmistot eroavat hieman ko-
neelle asennettavista versioista.

1. Käynnistä Excel.

2. Syötä mittaustulokset Excelin laskentataulukkoon. Huomaa, että vie-
rekkäisissä lukupareissa vasen sarake on oletuksena x-akselin arvo ja
oikea y-akselin.

3. Maalaa piirretävät arvot, valitse Insert ja Scatter -pudostusvalikosta
Scatter ilman viivoja.

12



1.2 Kuvaaja Microsoft Excelillä 1 KUVAAJAT

4. Nyt laskentataulukkoon muodostuu muokkaamaton kuvaaja.

5. Kuvaajan muokkaaminen

• Klikkaa kuvaajaa, jolloin kuvaajaan oikeaan yläkulmaan ilmestyy
Chart Elements ja Chart Styles -valikot.

• Akseleiden nimeäminen: Aktivoi Chart Elements -valikosta Axis
Titles, jolloin akseleiden viereen ilmestyy tekstit Axis Title.
Voit muokata tekstejä kaksoisklikkaamalla. Kirjoita laatikoihin ak-
seleiden otsikot ja käytetyt yksiköt. Muokkaa sekä x- että y-akselin
otsikko.

• Muokataan myös muita akseleiden asetuksia. Kaksoisklikkaamalla
haluttua akselia Excelin oikeaan laitaan avautuu Format Axis -
valikko, josta asetukset löytyvät. Korjataan aluksi akseliden alku-
ja loppuarvot. Kuvassa ei saa olla alueita, joissa ei ole mitään. Axis
Options kohtaan voi asettaa halutut alku- ja loppuarvot. Asete-
taan x-akselille uusi loppuarvo: Minimum → 10,0 ja Maximum →
35,0. Vastaavasti y-akselille uudet alku- ja loppuarvot: Minimum
→ 0,0 ja Maximum → 260,0. Y-akselin asetukset saat esiin kak-
soisklikkaamalla akselia.

• Lisätään molemmille akseleille myös jakovälimerkit valitsemalla
Tick Marks kohdasta Major type → Inside
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1.2 Kuvaaja Microsoft Excelillä 1 KUVAAJAT

• Muita asetuksia Format Axis -valikossa:

– Major unit ja Minor unit asettaa jakovälimerkit halutulla
tiheydellä.

– Tick Marks muokaavat jakovälimerkkien esitystapaa.

– Horizontal/Vertical axis crosses säätää y-akselin paik-
kaa x-akselilla. Tätä tarvitaan silloin, kun halutaan y-akseli
leikkaamaan x-akselin muualla kuin pisteessa x = 0.

6. Akselien lukuarvojen fonttikoon muuttaminen.

• Valitse haluttu muotoiltava teksti. Klikkaa haluttua tekstiä esim.
x-akselin lukuarvoa. Nyt voit muokata numeroiden arvoja Home-
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1.2 Kuvaaja Microsoft Excelillä 1 KUVAAJAT

välilehden fonttiasetuksista. Samalla tavalla voit muokata y-akse-
lin arvoja ja akseleiden otsikkotekstejä.

7. Otsikkotekstin ja vaakaviivat saa poistettua kuvasta klikkaamalla ku-
vaa ja poistamalla Chart Elements -valikosta valinnat Chart Title
ja Gridlines.

8. Kuvattujen lukuarvojen symboleita voi muokata kaksoisklikkaamalla
symbolia, jolloin avautuu Format Data Series -ikkuna. Sen Marker -
kohdassa voi vaihtaa symbolin tyyliä ja kokoa. Marker Fill -kohdassa
voi vaihtaa väriä yms. Vastaavasti Line -kohdassa voi halutessaan muo-
kata viivojen ominaisuuksia.

9. Akseleiden paksuutta ja väriä voi muokata kaksoiklikkaamalla niitä,
jolloin avautuu Format Axis -ikkuna. Line Color ja Line Style -
valikoista saa säädettyä akseliden väriä ja leveyttä.

10. Jos kuvaan haluaa akseleiden suuntaiset viivat ylös ja oikealle, niin ne
saa klikkaamalla valkoista kuva-aluetta, jolloin avautuu Format Plot
Area -ikkuna. Viivat saa tuotettua valitsemalla Border→ Solid line.
Viivojen ominaisuuksia saa säädettyä samasta valikosta.

11. Kuvatekstejä saa lisättyä, poistettua ja muokattua Chart Elements
-valikosta, esimerkiksi voit tarvittaessa lisätä Legend -tekstin ilmoitta-
maan eri mittaussarjoja.

12. Valmiin kuvan saa siirrettyä tekstinkäsittelyohjelmaan leikkaa-liimaa-
menetelmällä (Copy-Paste).

13. Kuvan tallentaminen tiedostoksi (.png) onnistuu klikkaamalla kuvaajaa
hiiren oikealla näppäimellä ja valitsemalla Save as Picture....
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1.2 Kuvaaja Microsoft Excelillä 1 KUVAAJAT

14. Edellä mainittujen muokkausten avulla kuvasta on saatu tämän näköi-
nen.

Kuva 3. Esimerkkikuva Excelillä tehdystä kuvaajasta.

15. Kuvat tulee numeroida ja niihin tulee lisätä kuvateksti kuvan alapuo-
lelle. Kuvateksti päättyy pisteeseen.
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2 SUORAN SOVITUS

2 Suoran sovitus

Suoran sovitusta tarvitaan useissa laboratoriotöissä lineaarisen tai linearisoi-
dun mittausdatan kulmakertoimen ja leikkauspisteen määrittämiseen. Suo-
ran sovitus onnistuu helposti sekä OriginPro että Excel ohjelmistoilla.

2.1 Suoran sovitus OriginPro:lla

Suoran sovitus tehdään OrigonPro 2017 ohjelmassa Fitting -työkalulla. Käym-
me seuraavaksi lävitse pienimmän neliösumman (PNS) suoran sovituksen
OriginPro 2017 ohjelmalla. OriginPro 2017 ohjelman avamaaminen ja yksin-
kertaisen kuvaajan tekeminen on esitetty kappaleessa 1.1., johon voit tarvit-
taessa palata. Tässä ohjeessa oletetaan, että mittausdata ja kuvaaja on jo
valmiina OriginPro 2017 ohjelmistossa.

1. Kuvaajan ikkunan ollessa aktiivinen valitse Analysis -valikosta Fitting
→ Linear Fit → Open Dialog.

2. Ruutun avautuu Linear Fit -ikkuna. Klikkaa ikkunan alalaidassa ole-
vaa OK -painiketta.
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2.1 Suoran sovitus OriginPro:lla 2 SUORAN SOVITUS

3. Ruutun avautuu uusi ikkuna, jossa kysytään "Do you want to switch
to the report sheet?". Valitse Yes ja paina OK.

4. Tämän jälkeen saat sovituksen tiedot ja arvot virheineen näkyviin Book1
-ikkunaan uudelle välilehdelle. Sovituksen perustiedot kuten kulmaker-
roin ja leikkauspiste sekä niiden virheet tulostuvat myös kuvaajaasi,
jossa voit siirtää ne hiirellä parempaan paikkaan kuvassa. Parametrit
voi vaihtoehtoisesti poistaa kuvaajasta, mikäli ne ilmoitetaan kuvaajan
kuvatekstissä.

5. Valmiin kuvaajan sovituksineen voit tallentaa kappaleessa 1.1 olevien
ohjeiden mukaan.
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2.2 Suoran sovitus Excelillä 2 SUORAN SOVITUS

2.2 Suoran sovitus Excelillä

Suoran sovitus onnistuu Excelissä helpoiten käyttämällä Excelin LINEST funk-
tiota. Suomenkielisessä Excelissä funktion nimi on LINREGR, mutta sen käyt-
tö vastaa englanninkielistä. Käytetään esimerkissä kohdassa 1 taulukoitua
mittausdataa. Oletuksena on, että mittausdata on jo syötetty Exceliin.

1. Valitse tyhjä solu ja kirjoita siihen =LINREGR(.

2. Maalaa tämän jälkeen y-akselin arvot (1/[A]) ja lisää puolipiste ;.

3. Maalaa tämän jälkeen x-akselin arvot (Aika) ja lisää puolipiste ;.

4. Mikäli haluat leikkauspisteen olevan erisuuri nollasta syötä seuraavaksi
1 ja lisää puolipiste ;. Jos taas haluat leikkauspisteen olevan nolla,
syötä 1 tilalle 0.

5. Syötä lopuksi toinen 1 ja päätä funktio kaarisulkeella ) ja paina Enter.

6. Suoransovituksen parametrit ilmestyvät Exceliin muiden statististen
parametrien kanssa.
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2.2 Suoran sovitus Excelillä 2 SUORAN SOVITUS

7. Syntyvän taulukon ylimmällä rivillä ovat suoran kulmakerroin (0,1) ja
leikkauspiste (10). Näiden alapuolella ovat arvojen vastaavat virheet.
Kolmannen rivin ensimmäisessä solussa on ns. R2-arvo. Tässä tapauk-
sessa R2 = 1, koska kaikki pisteet osuvat täydellisesti suoralle. Muista
parametreistä ei tarvitse välittää.

8. Tarvittaessa suoran voi lisätä myös edellisessä piirrettyyn kuvaajaan.
Lisää suoran sovituksen suora aktivoimalla kuvaaja ja valitsemalla Chart
Elements -valikosta Trendline → Linear.

9. Piirretyn suoran parametreja voi muokata suoraa kaksoisklikkaamalla
avautuvasta Format Trendline -valikosta.
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10. Suoran yhtälön voi tarvittaessa lisätä kuvaajaan valitsemalla asetuk-
sista Display Equation on chart. Huomaa kuitenkin, että suoranso-
vituksen parametrit virheineen tulee määritää suoransovituksen kautta
yllä kuvatulla tavalla.
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3 TAULUKOT

3 Taulukot

Taulukoiden avulla voidaan esittää helposti ja havainnollisesti numeerista
dataa. Taulukoiden tulee olla helposti luettavia. Taulukoissa tulee myös aina
näkyä käytetyt yksiköt.

Käytetään seuraavassa esimerkissä aiemmin esitettyä taulukkoa ja muotoil-
laan se selostukseen sopivaan muotoon.

3.1 Taulukko Wordilla

Taulukon tekeminen Wordilla on helppoa.

1. Insert -välilehdellä valitaan Table ja valitaan haluttu taulukon ko-
ko. Nyt data on kahdessa sarakkeessa, joissa on molemmissa 6 arvoa.
Sen lisäksi tarvitaan vielä otsikkorivi sarakkeille. Tarvitaan siis 2×7
kokoinen taulukko.

2. Avautuneeseen taulukkopohjaan kirjoitetaan tarvittavat arvot:
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3.1 Taulukko Wordilla 3 TAULUKOT

3. Arvot on myös mahdollista kopioida taulukkoon suoraan Excelistä leikkaa-
liimaa-menetelmällä (Copy-Paste). Valitse kopioivat arvot Excelistä ja
kopioi arvot painamalla Ctrl+C. Valitse tämän jälkeen Word taulukos-
ta saman kokoinen alue, esimerkiksi tässä tapauksessa 2×7 alue mi-
käli lukuarvojen otsikot kopioidaan myös Exclistä. Tämän jälkeen lii-
tä arvot Word-taulukkoon painamalla Ctrl+V. Mikäli haluat säilyttää
Word taulukon alkuperäiset muotoilut (fontti, fonttikoko, ym.), liitä
arvot määräten painamalla Ctrl+Alt+V ja valitsemalla Unformatted
Text.

4. Yllä esitetty perustaulukko on vielä täysin ilman muotoiluja, eikä näy-
tä erityisen hyvältä. Ensimmäiseksi keskitetään tekstit. Maalataan tau-
lukko (joko hiirella vasen nappi pohjassa tai klikkaamalla taulukon va-
semman yläkulman nuolimerkkiä), jolloin yläpalkkiin ilmestyy Layout
-välilehti. Keskitetään teksti klikkaamalla Align Center -painikkeesta.
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5. Samalla voit sovittaa taulukon koon sen sisällön mukaan: Layout -
välilehti ja AutoFit → AutoFit Contents.

6. Nyt taulukon teksti on keskitetty ja taulukko on järkevän kokoinen.
Taulukon kokoa ja sarakkeiden leveyksiä voi muokata hiirellä vetämällä
tai Layout -välilehden Height- ja Width -arvoilla.

7. Poistetaan turhat viivat taulukosta. Normaalisti taulukossa on vaaka-
viiva ylimpänä, seuraavaksi on otsikkorivi, jonka alla on vaakaviiva.
Taulukon päättää alimman rivin alapuolinen vaakaviiva. Taulukon ul-
konäköä voi vaihtaa Table Design -välilehden valmiiden taulukkotyy-
lien mukaan (Table Styles) tai muokkaamalla itse. Selkeä taulukko
ei tarvitse mitään ylimääräistä. Table Desing -välilehden Borders-
valikon avulla voi säätää taulukon viivoja.

8. Taulukon tekstin fonttia, fonttikokoa ja tyyliä voi vaihtaa Home -välilehden
asetuksista. Valitse ensin muokattava teksti hiirellä ennen asetuksien
vaihtamista.
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9. Taulukkoa voi siirtää raahaamalla sitä vasemman yläkulman nuoli-
merkistä. Taukon sijoittumista suhteessa tekstiin (Alignment ja Text
wrapping) voi myös säätää Layout -välilehden Properties -valikosta.

10. Tässä esimerkki yksinkertaisesta hyvin muotoillusta taulukosta.

Taulukko 1. Kuvaus taulukon sisällöstä

11. Taulukot tulee numeroida ja niihin tulee lisätä taulukko teksti taulukon
yläpuolelle. Taulukkoteksti ei pääty pisteeseen.
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4 Matemaattiset kaavat

Tässä osiossa käydään läpi kaavan kirjoittamisen, kursivoinnin ja numeroin-
nin periaatteet Wordin kaavaeditorilla. Matemaattiset kaavat tulee kirjoit-
taa selkeästi ja ne tulee pääsääntöisesti keskittää sekä numeroida. Kaavan
numerointi tulee kaavariville oikeaan reunaan kaarisulkeiden sisään. Huomaa
kuitenkin, että laskuesimerkkejä ja sijoituksia ei tule numeroida.

4.1 Kaavojen ja muuttujien kursivointi

Kaavojen ja muuttujien kursivointiin tulee kiinnittää erityistä huomiota.
Kaikki muuttujat, esimerkiksi E, V ja p, ja kemialliset vakiot, kuten R ja F
tulee esittää kursivoidulla eli vinolla kirjasimella yhtälöissä, tekstissä, kuvaa-
jissa ja taulukoissa. Kuitenkin tekstimuotoiset alaindeksit (esimerkiksi lähtö-
aineet ja tuotteet), yksiköt (esimerkiksi kJ, K, mol ja Pa), kemialliset kaavat
(esimerkiksi NaOH, H2SO4 ja Na+), logaritmimerkinnät (log ja ln) ja muut
matemaattiset operaattorit esitetään normaalilla kirjasimella. Tämän lisäksi
eräitä vakiintuneita merkintöjä, kuten pH ja pOH ei myöskään kursivoida.

Kaavan kirjoittamista selkeytetään seuraavan esimerkin avulla, jossa kaava
on muotoa lnK = −∆H◦

rxn
R

(
1
T

)
+ ∆S◦

rxn
R

.

Kaavassa kaikki muuttujat on kursivoitu, mutta tekstimuotoiset alaindek-
sit (rxn = reaction) sekä logaritmimerkintä (ln) on esitetty normaalilla pys-
tytekstillä. Mikäli lauseke sisältää yksiköitä ja numeroita, myös ne esitetää

pystytekstinä. Esimerkiksi ∆H◦
rxn︸ ︷︷ ︸

muuttuja

= 2500
kJ
mol︸︷︷︸

yksikkö

4.2 Kaavojen kirjoittaminen ja numerointi Wordilla

Wordilla kaavojen tekeminen onnistuu kaavaeditorilla. Myös kaavojen nume-
rointi onnistuu vaivatta seuraavien ohjeiden mukaisesti.
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1. AvataanWordin kaavaeditori Insert-välilehdellä klikkaamalla Equation
-painiketta.

2. Kirjoitetaan kappaleen alussa esitetty esimerkkikaava. Seuraavissa oh-
jeissa ollaan Equation -valikossa, ellei toisin mainita. Ympäristön saa
aktivoitua klikkaamalla Insert -välilehden Equation -painiketta.

3. Kirjoitetaan ensiksi lnK. Huomaa, että ln on pystytekstiä ja K on
kursiivilla. Kaavaeditori tekee automaattisesti kaikesta kursiivia. ln-
tekstin saat normaaliksi pystytekstiksi maalaamalla sen ja klikkaamalla
ab Text -painiketta.

4. Kirjoitetaan yhtäsuuruusmerkin jälkeinen murtolauseke. Lisää ensin
miinusmerkki (-) näppäimistöstä ja valitse tämän jälkeen Fraction -
pudotusvalikosta oikeanlainen murtolausekkeen muotoilu.
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5. Ylempään laatikkoon kirjoitetaan jakoviivan yläpuolinen asia.

6. Iso delta, ∆, löytyy Symbols -valikon Basic Math -osiosta. Valikon saa
laajennettua klikkaamalla ensin valikon oikean laidan alaspäin osoitta-
vaa nuolenkärkeä.

7. Seuraavaksi kirjoitetaan H, jossa on sekä ylä- että alaindeksi. Valitaan
ensiksi Script -valikosta merkkialusta, joka mahdollistaa ylä- ja alain-
deksin lisäämisen.
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8. Kirjoitetaan isoon ruutuun H (automaattisesti kursiivi), alaindeksin
laatikkoon rxn ja yläindeksin laatikkoon valitaan Basic Math -valikos-
ta asteen merkki °. Huomaa, että esimerkissä teksti rxn on normaalia
pystytekstiä. Sellaiseksi sen saa maalaamalla tekstin ja klikkaamalla ab
Text -painiketta.

9. Viimeisenä lisätään viivan alle R.

10. Seuraavaksi lisätään suluissa oleva murtolauseke. Valitaan Bracket -
valikosta kaarisulkeet. Nämä sulkeet skaalautuvat sisällön mukaan toi-
sin kuin näppäimistön sulkumerkit.
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11. Valitaan sulkujen sisään murtolauseke ja kirjoitetaan siihen tarvittavat
muuttujat.

12. Lisätään tämän perään plusmerkki näppäimistöltä ja kirjoitetaan jä-
limmäinen termi käyttämällä edellä opittuja menetelmiä.

13. Ennen poistumista kaavaeditorista, kirjoitetaan kaavan loppuun #(1),
jossa numero viittaa kaavan numeroon. #-merkki ilmoittaa kaavaedi-
torille, että merkin jälkeiset asiat viittavat kaavan numerointiin.

14. Painetaan tämän jälkeen Enter ja kaavaeditori numeroi ja keskittää
kaavan automaattisesti.

15. Kaavan numerointia voi muuttaa jäkikäteen maalaamalla sulkeiden si-
sällä oleva numero ja syöttämällä uusi.
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5 Numeeristen tulosten esittäminen

Kaikki kokeelliset mittaukset sisältävät epätarkkuutta, jolloin lopputulosten
arvot eivät ole absoluuttisia. Tulosten tarkkuus riippuu muun muassa käyte-
tystä menetelmästä, analyysistä, laitteista ja tekijästä. Virhelähteiden tun-
nistaminen ja lopputuloksen epätarkkuuden määrittäminen ovat keskeinen
osa kvantitatiivista analyysiä.

5.1 Virhelähteet ja virheiden arvioiminen

Mittavälineissä usein ilmoitetaan mittaustarkkuus, joka tulee kirjata ylös
ja huomioida lopputuloksissa. Esimerkiksi mittapullossa voi olla merkintä
“(50 ± 0,08) ml, In 20◦C”, joka tarkoittaa mittapullon tilavuuden olevan vä-
lillä 49,92–50,08 ml nesteen ja pullon lämpötilan ollessa 20◦C. Tämän lisäksi
laitteilla ja eri menetelmillä on omat tarkkuutensa eli kuinka lähelle todellista
tulosta voidaan päästä tietyissä olosuhteissa (konsentraatio, lämpötila).

Useissa laboratoriotöissä lopputulos saadaan suoran sovituksen tai usean mit-
tauksen keskiarvon kautta. Tällöin yksittäisten mittavälineiden virheitä ei
huomioida, koska suoran sovitus tai keskiarvo ottaa näiden epätarkkuudet
jo huomioon. Suoran sovitus tuottaa automaattisesti suoran sovituksen pa-
rametrien, kulmakerroin ja leikkauspiste, virheet (osio 2). Keskiarvona mää-
ritetyn tuloksen virheenä tulee käyttää keskiarvon keskivirhettä σx. Esimer-
kiksi jos tulos x mitattiin N kertaa, ilmoitetaan lopputuloksena mittausten
keskiarvo x ja virheenä keskiarvon keskivirhe σx. Tulokset voidaan laskea
seuraavien yhtälöiden avulla:

x =
1

N

N∑
i=1

xi (1)

σx =

√∑
(xi − x)2

N − 1
(2)

σx =
σx√
N
. (3)
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Yhtälöissä (1)-(3) N on mittausten määrä, xi yksittäisen mittauksen tulos ja
σx on keskihajonta. Keskiarvon ja keskihajonnan voi laskea myös käyttämällä
Excelin ’KESKIARVO’ (engl. ’AVERAGE’) ja ’KESKIHAJONTA.S’ (engl.
’STDEV.S’) -funktioita. Keskiarvon keskivirheen laskemiseen tarvittavan ne-
liöjuuren saa laskettua Excelin ’NELIÖJUURI’ (engl. ’SQRT’)-funktiolla.
Ohjeita Excelin funktioiden käyttöön voi katsoa Excelin Help -valikosta funk-
tion nimellä.

Mikäli lopputulos määritetään epäsuorasti usean eri parametrin avulla, pa-
rametrien epätarkkuuksien yhteisvaikutusta lopputulokseen voidaan arvioi-
da virheen etenemislain avulla. Virheen etenemislaki voidaan yleisesti esittää
muodossa:

δf =

√√√√∑
i

(
∂f

∂xi
δxi

)2

, (4)

missä δf on epäsuorasti määritetyn tuloksen f virhe, ∂f/∂xi yhtälön f osit-
taisderivaatta parametrin xi suhteen ja δxi parametrin xi virhe. Esimerkiksi
suorakaiteen, jonka sivujen pituudet ovat a ja b ja niitä vastaavat virheet δa
ja δb, pinta-ala voidaan laskea yhtälöllä A = a · b, jolloin sitä vastaava virhe
yhtälön (4) mukaisesti on:

δA =

√(
∂A

∂a
δa

)2

+

(
∂A

∂b
δb

)2

=

√
(b · δa)2 + (a · δb)2 (5)

5.2 Tulosten esitystarkkuus ja pyöristäminen

Välitulokset ja muut numeeriset arvot, joiden virhettä ei tarkastella, ilmoite-
taan yhtä monella merkitsevällä numerolla kuin laskun tai mittauksen epä-
tarkimmassa arvossa on käytetty. Tämän vuoksi lukujen asiayhteyteen tu-
lee kiinnittää huomiota. Esimerkiksi jos ohjeessa on kerrottu työssä käytet-
tävän 200 millilitran mittapulloja, joiden tarkkuus on (200,00 ± 0,01) ml,
tällöin luvussa 200,00 on viisi merkitsevää numeroa. Tulosta ilmoitettaes-
sa tulee muistaa, että desimaaliluvun alussa olevat nollat tai kokonaislu-

32



5.2 Tulosten esitystarkkuus ja pyöri‌ . . . 5 NUMEERISTEN TULOSTEN E‌ . . .

vun lopussa olevat nollat eivät ole merkitseviä. Esimerkiksi luvuissa 12340,
123400000, 0,001234 ja 0,0000001234 on neljä merkitsevää numeroa, mutta
luvussa 1234,00 on kuusi merkitsevää numeroa. Suomenkielisissä teksteissä
desimaalilukujen erottimena käytetään pilkkua kun taas englanninkielisissä
teksteissä erottimena käytetään pistettä.

Mikäli lopputuloksen virhe tunnetaan, tuloksen esitystarkkuus määräytyy
virheen suuruudesta. Kemian ja fysiikan laboratoriossa vakiintunut tulosten
ilmoitustarkkuuskäytäntö on viidentoista yksikön sääntö, jonka mukaan virhe
voi olla korkeintaan 15-yksikköä. Tulos ilmoitetaan aina samalla tarkkuudella
virheen kanssa. Virheen pyöristämiseen sovelletaan seuraavia sääntöjä:

Sääntö 1: Virhe pyöristetään yhden merkitsevän numeron tarkkuuteen, ja
varsinainen mittaustulos pyöristetään samaan tarkkuuteen. Jos virhe pyöris-
tyy esim. sadasosan tarkkuuteen, tuloskin pyöristetään sadasosan tarkkuu-
teen, jne. Tämä sääntö johtaa joissakin tilanteissa varsin rankkoihin pyöris-
tyksiin. Tämän vuoksi kyseistä sääntöä on lievennetty niin kutsutulla 15-
yksikön säännöllä.

Sääntö 2: Virhe pyöristetään aina ylöspäin, tulos normaalisti.

15-yksikön sääntö: Seuraavissa kahdessa tapauksessa virheen ilmoittami-
seen käytetään kahden merkitsevän numeron tarkkuutta:

1. Virheen ensimmäinen merkitsevä numero on 1 ja toinen korkeintaan 4
(tai 5 ja perässä vain nollia).

2. Virheen ensimmäinen merkitsevä numero on 9 ja jokin sitä seuraavista
numeroista on suurempi kuin nolla.

Kun virhe ilmoitetaan 15-yksikön säännön mukaan, virhe on korkeintaan 15
tuloksen vähiten merkitsevää desimaalia. 15-yksikön säännön mukaan virhe
voi siis olla enintään 0,015, 0,15, 1,5 jne. Heti, jos virheeksi saadaan esimer-
kiksi 0,152, pyöristetään sekä lopputulos että virhe kymmenysosien tarkkuu-
teen. Kohdan 2) tapauksissa virhe pyöristettynä on esim. 0,10, 0,010 jne.
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Esimerkkejä:

131,8± 7,6→ 132± 8 (säännöt 1 ja 2)

131± 17→ 130± 20 (säännöt 1 ja 2)

31628± 1273→ 31600± 1300 (sääntö 2 ja 15-yksikön sääntö)

3,1678± 0,0873→ 3,17± 0,09 (säännöt 1 ja 2)

3,1678± 0,0973→ 3,17± 0,10 (sääntö 2 ja 15-yksikön sääntö)

3,1678± 0,1073→ 3,17± 0,11 (sääntö 2 ja 15-yksikön sääntö)

3,1678± 0,1573→ 3,2± 0,2 (säännöt 1 ja 2)

1,161 · 10−18 ± 4,9 · 10−20 → (1,16± 0,05) · 10−18 (säännöt 1 ja 2)

Kuten esimerkeistä havaitaan, tulosten pyöristämiseen käytetään siis aina
sääntöä 2 ja joko sääntöä 1 tai 15-yksikön sääntöä.
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6 Kemialliset kaavat ja reaktioyhtälöt

Kemialliset kaavat ja reaktioyhtälöt kertovat mm. mistä yhdisteestä on kyse
tai mitä kemiallisessa reaktiossa tapahtuu. Yleisesti kemiallisista yhdisteistä
tulee mainita yhdisteen nimi ja rakennekaava. Esimerkiksi metaani, CH4.
Myös triviaalinimiä voi käyttää silloin, kun ne ovat yleisesti tunnettuja kuten
asetoni (C3H6O, 2-propanoni, dimetyyliketoni)

Erityisen tärkeää kemiallisten kaavojen kirjoittamisessa on selkeys. Veden
kemiallinen kaava ei ole H2O vaan H2O. Ylä- ja alaindeksien käyttö on tär-
keää selkeyden vuoksi. Esimerkiksi ammoniumioni, NH+

4 , on huomattavan
vaikeaselkoinen, jos se esitettäisiin muodossa NH4+.

Usein kemiallisen kaavan lisäksi on tarpeen lisätä myös merkintä aineen olo-
muodosta (faasista). Olomuoto merkitään kemiallisen kaavan perään suluissa
kursiivilla:

Faasi Faasimerkintä Esimerkki

Kiinteä (s) H2O(s)
Neste (l) H2O(l)
Kaasu (g) H2O(g)

Selkeyden vuoksi kemiallisen kaavan ja faasimerkinnän väliin voi kirjoittaa
pienen välin (pienempi kuin välilyönti!).

Tärkeää on huomata, että kemiallisissa kaavoissa aineiden kemialliset merkit
kirjoitetaan pystytekstinä (ei kursiivilla). Tämä seikka tulee vastaan teks-
tinkäsittelyohjelmien kaavaeditoreja käytettäessä.

Kemialliset reaktiot esitetään usein samalla tavalla kuin matemaattiset kaa-
vat: keskitettyinä ja numeroituina. Reaktioyhtälöiden numeroinnissa käyte-
tään tavallisten numeroiden lisänä kirjainta R, esim. R1, R2, R3, jne. Tällöin
numerointi ei sotke matemaattisten kaavojen numerointia.
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6.1 Kemialliset kaavat ja reaktioyhtälöt Wordissä

Yksittäisen molekyylin kirjoittaminen voidaan tehdä helposti käyttäen alain-
deksejä Subscript ja yläindeksejä Superscript:

Kun molekyylin kaavassa on sekä ylä- että alaindeksejä, useimmiten on pa-
rempi käyttää kaavaeditoria. Tässä ammoniumioni kirjoitettuna Wordilla eri
tavoin:

Ylä- ja alaindeksejä käyttämällä + ja 4 eivät sijoitu oikein. Kaavaeditorilla
+ ja 4 saadaan sijoitettua oikein kemiallisiin merkkeihin nähden käyttäen
Script -valikon asetteluja:
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Reaktioyhtälöiden kirjoittamisessa kannattaa käyttää kaavaeditoria. Reak-
tioyhtälöt voidaan kirjoittaa matemaattisten kaavojen kirjoittamiseen an-
nettujen ohjeiden pohjalta. Ainoastaan numerointi eroaa tässä tapauksessa.
Esimerkiksi:

Kaavaeditorista löytyy myös nuolia, joiden ylä- ja/tai alapuolelle voi kirjoit-
taa tekstiä. Myös tasapainonuolen (
) lisääminen onnistuu kaavaeditorilla.
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7 Kemialliset rakennekaavat

Kemiallisten rakennekaavojen piirtäminen on yksi keskeinen kemistin tai-
to. Tyypillisesti yhdisteistä esitetään rakennekaavat. Katso vaikka kemian
oppikirjoja tai muita kemian julkaisuja. Opintojen edistyessä myös kemian
tietokannat tulevat tutuiksi. Monet näistä tietokannoista mahdollistavat te-
hokkaan haun rakennekaavojen avulla. Näistä syistä rakennekaavojen piir-
täminen on hyvä opiskella mahdollisimman aikaisessa vaiheessa opintoja.
Tässä ohjeessa käydään läpi lyhyesti perusominaisuudet ChemOffice 2020
-ohjelmistopaketin ChemDraw-ohjelmistosta. ChemOffice on yleinen teolli-
suudessa käytetty ohjelmisto.

7.1 Rakennekaava ChemDraw’lla

Avaa ChemDraw. Asetuksista riippuen ohjelmaan avautuu useita tyäkalurive-
jä ja valikoita. View -valikosta voi avata ja sulkea halutut valikot ja työkalut.
Tärkein työkaluvalikko on vasemmalta löytyvä päätyökaluvalikko, joka avau-
tuu yleensä ohjelman avautuessa. Tarvitteaessa sen saa auki View -valikosta.
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Piirretään esimerkissä kofeiinin (C8H10N4O2) rakennekaava:

N

N N

N

O

O
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1. Valitaan ensimmäiseksi oikea tyyli: View → Open Style Sheets →
ACS Document 1996.

Eri julkaisusarjat käyttävät erilaisia tyylejä rakennekaavojen esitykses-
sä. Yksi yleisimmin käytetyistä tyyleistä on esimerkkiin valittu ACS
Document 1996. Tätä tyyliä käytetään esimerkiksi kaikissa ACS:n jul-
kaisusarjoissa. Tyylejä käyttämällä yhdisteistä saadaan suoraan halu-
tun näköisiä eikä kaikki asetuksia tarvitse tällöin säätää itse.

2. Valitaan sykloheksaanirengas Tools -ikkunasta
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ja klikataan työalustaa sykloheksaanin lisäämiseksi haluttuun kohtaan.

3. Lisätään seuraavaksi syklopentaanirengas.
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Valitse syklopentaanirangas valikosta

ja vie kursori kohtaan, johon syklopentaani halutaan liittää (ko. sidos
korostuu sinisellä). Klikkaa hiiren vasenta näppäintä liittäksesi syklo-
pentaanirenkaan kiinni sykloheksaanirenkaasaan.
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4. Lisätään kaksoissidos sidokseen, johon syklopentaani liitettiin. Valitse
Solid Bond

ja vie kursori haluttuun kohtaan (sininen palkki ilmestyy, kun olet oi-
keassa kohdassa) ja liitä sidos klikkaamalla hiiren vasenta nappia.
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5. Lisää samalla tavalla toinen kaksoissidos syklopentaanirenkaaseen.

Huomaa kuinka ChemDraw korjaa automaattisesti toisen kaksoissidok-
sen paikan. Se oli alunperin sykloheksaanirenkaan sisällä, nyt se on
syklopentaanirenkaan sisällä.

6. Korvataan tarvittavat hiilet typpiatomeilla. Valitse Text -työkalu
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Vie kursori korvattavan hiilen päälle (sininen korostusväri ilmestyy) ja
klikkaa hiirellä. Kirjoita N.

7. Lisää samalla tavalla loput typpiatomit.

Huomaa, että typpiatomit, jotka osallistuvat vain kahteen sidokseen
ovat ympäröityinä punaisella neliöllä, koska valenssielektronirakenne ei
vastaa sidosten lukumäärää.

8. Lisää punaisilla korostettuihin typpiatomeihin CH3-ryhmät. Valitse Solid
Bond (katso kohta 4) ja klikkaa typpiatomeja.

N

N N

N

9. Lisää kaksoisidokset, joihin happi liittyy. Valitse Multiple Bonds -
työkalu. Huomaa, että Multible Bonds -valikossa on useita erilaisia
sidosvaihtoehtoja, jotka saat näkyviin pitämällä hiiren vasenta nappia
pohjassa.
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10. Klikkaa kaksoissidokset haluttuun kohtaan yhdisteessä.
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N

N N

N

11. Lisää kaksoissidosten vapaisiin päihin happiatomit Text -työkalulla (kat-
so kohta 6).

12. Kofeiinin rakennekaava on valmis:

N

N N

N

O

O

13. Tehdyt toimempiteet voi poistaa yhdisteestä valitsemalla haluttu alue
(Lasso- tai Marquee -työkalulla) ja poistamalla Deletellä.

14. Lasso- tai Marquee -työkalulla voi valita koko molekyylin tai osan siitä
kopiointia varten.

15. Muita hyödyllisiä toimintoja ChemDraw:ssa ovat mm.

• Structure→ Convert Structure to Name, joka antaa IUPACin
mukaisen nimen valitulle rakenteelle.

47



7.1 Rakennekaava ChemDraw’lla 7 KEMIALLISET RAKENNEKAA‌ . . .

• Structure → Convert Name to Structure, jolla voi hakea ni-
meä vastaavan valmiin rakenteen.
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8 Laitteistokuvat

Tyypillisesti tutkimuksessa käytettävät laitteistot esitellään raporteissa vä-
hintään mallinimeltä sekä tärkeimmiltä ominaisuuksiltaan. Usein laitteistois-
ta esitetään myös kuva, joka selventää laitteistoa. Useimmiten laitteistosta
esitetään ns. viivapiirrokset, mutta nykyaikaiset ohjelmistot mahdollistavat
myös viimeistellymmät laitteistokuvaukset. On kuitenkin muistettava, että
kuvan tärkein tarkoitus on kertoa keskeiset seikat laitteistosta. Tähän tar-
koitukseen selkeä viivapiirros sopii usein erittäin hyvin. Viivapiirroksia voi
tehdä käytännössä kaikilla tekstinkäsittelyohjelmilla, joissa on piirtotyökalut
tai jopa Paintilla.

Seuraavassa esitetään esimerkkinä kuinka tislauslaitteisto voidaan piirtää
ChemDraw:lla.

8.1 Tislauslaitteisto ChemDraw:lla

1. Avaa ChemDraw

2. Valitse View → Templates → Clipware, part 1 ja View → Temp-
lates → Clipware, part 2. Nyt ohjelmassa on auki kaksi ikkunaa,
jotka pitävät sisällään erilaisia laboratoriotarvikkeita.

3. Valitse statiivi klikkaamalla sitä hiirellä ja aseta se haluamaasi kohtaan
työpöydälle klikkaamalla.

4. Lisää koura, tislauskolvi, tislausväliosa...
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• Viimeksi lisättyä kappaletta voi liikuttaa joko hiirellä tai nuolinäp-
päimillä. Kappale tulee valita aktiiviseksi painamalla esimerkiksi
Tools -valikon Lasso -työkalulla.

• Kappaleita voi pyöritellä ja peilata. Nämä operaatiot saa klikkaa-
malla aktiivista kappaletta hiiren oikealla näppäimellä.

• Aktiiviset kappaleet saa poistettua delete -näppäimellä.

• Tekstiä saa lisättyä Tools -valikon Text -työkalulla.

• Lisää piirtotyökaluja löytyy valikosta View → Other Toolbars.

5. Harjoituksena voi koota vaikka seuraavanlaisen laitteiston.

statiivi

koura

tislauskolvi

lämpömittari

tislausväliosa

Liebig-jäähdytin

tislausmutka

vastaanotto-

kolvi
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